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Preface

Thank you for purchasing this Topcon product. The materials available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon products, and are designed to assist owners with the use of the
receiver and its use is subject to these terms and conditions (the “Terms and Conditions”).

Please read the terms and conditions carefully.

Terms and Conditions

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local government protection agency for both private use and
commercial job sites.
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Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved.
Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party access
to, any graphics, content, information or data in this Manual without TPS’ express written consent and may only use such
information for the care and operation of the receiver. The information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and money, and are the result of original selection, coordination
and arrangement by TPS.

Trademarks

GR-5, Vanguard Technology™, Fence Antenna™ Technology, TRU™, Magnet™, Pocket-3D™, Topcon® and Topcon Positioning
Systems™ are trademarks or registered trademarks of TPS. Windows® is a registered trademark of Microsoft Corporation. The
Bluetooth® word mark and logos are owned by Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems,

Inc. is used under license. Other product and company names mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL AND
THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE LIABLE FOR
TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL OR THE RECEIVER. SUCH DISCLAIMED
DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR COSTS

Terms and Conditions P/N: 7010-1004 X
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INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR
ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER
PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.

2dkjold

License Agreement

Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”) in connection
with the receiver constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use such Software under the
terms stated herein and in any case only with a single receiver or single computer. You may not assign or transfer the Software
or this license without the express written consent of TPS. This license is effective until terminated. You may terminate the
license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply with any of the
Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the receiver. All ownership,
copyright and other intellectual property rights in and to the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary
information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you from
disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the receiver.
Such employees must also keep the Confidentiality Information confidential. In the event you become legally compelled to
disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a protective order or other
appropriate remedy.
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Website; Other Statements

No statement contained at the TPS website (or any other website) or in any other advertisements or TPS literature or made by
an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software license, warranty
and limitation of liability).

2dkjold

Safety

Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The receiver should
only be repaired by authorized TPS warranty service centers.

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms and
Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference to
conflict of laws.
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Manual Conventions Y
0]
—rn
This manual uses the following conventions: %
Convention Description Example ()
Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click Exit)
Name of a dialog box or screen From the Connection screen...
Button or key commands Click Finish.
Mono User supplied text or variable Type guest , and click Enter.
Italic Reference to another manual or help document Refer to the Topcon Reference Manual.

Further information to note about system configuration, maintenance, or setup.

Supplementary information that can have an adverse affect on system operation, system performance, data
integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of warranty, or
personal injury.

QO G
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Introduction

Topcon’s GR-5 receiver is a compact and high-performing GNSS receiver for static and kinematic applications. The receiver design
includes a GNSS receiver board based on Vanguard Technology™, which provides unlimited tracking ability. The GR-5 delivers
world-class positioning and navigation capability to your application by tracking signals with multiple frequencies and multi-
constellation satellite systems.

Using full-wave Fence Antenna™ Technology, the GR-5 can receive and process multiple signal types, including the latest GPS L2C
and L5, and other future! signals. The GR-5 receiver includes an enhanced GNSS receiver board featuring Vanguard Technology
that supports 226 channels?.

GNSS tracking capabilities, dual-frequency RTK, SBAS functionality, extensive communication capabilities, removable memory for
files combine to provide a positioning system efficient, secure, and appropriate for any survey.

Several unique features, including advanced multipath mitigation, adjustable Phase-Locked Loop (LLP) and Delay-Locked Loop
(DLL), offer a reliable and versatile reception of weak signals even in degraded signal environments. The receiver also supports
Quartz Locked Look™ (QLL) for superior GNSS tracking in high-vibration environments.

The GR-5 offers complete IP66 protection against dust and water ingress, in addition to superior vibration and shock resistance.
The Topcon communication interface allows you to quickly integrate Topcon’s premium GNSS performance within new systems
and quickly deliver world-class positioning and navigation support to your applications.

1. The GR-5 receiver, equipped with a GNSS board featuring Vanguard technology, is a Galileo- and BeiDou-ready system. Full support of these new
constellation(s) and associated signals will be incorporated into the receiver when these constellations are mature and ready for commercial
use.

2. Earlier versions of the GR-5 were built with PIl ASIC-based GNSS boards and supported 216 universal tracking channels. See “Product
Identification” on page 102 for a list of new GR-5 receivers built with Vanguard technology-based GNSS receiver boards.

Introduction P/N: 7010-1004 1



GR-5 Features

The GR-5 receiver’s advanced design allows for a simplified setup and premium performance. The GR-5 receiver features the
following:

® A premier multi-constellation Vanguard technology GNSS board
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® Industry leading full-wave Fence Antenna technology
® Detachable batteries for extended operation
® Internal radio and cellular (optional) modems
* Integrated Bluetooth® wireless and radio technology
® Optional HSPA (3.5G)! and CDMA cellular technology
* Interface for controlling viewing data logging through the LED display
® External power, USB, and serial-data ports
® External high-capacity memory card support
The GR-5 comes in one of the following configurations:

® FH915+ radio modem

® FH915+ radio modem with HSPA module

® Digital UHF Il radio modem

® Digital UHF Il radio modem with HSPA module

® Digital UHF Il radio modem and CDMA module (US only)

1. High-Speed Packet Access (HSPA) cellular module supports faster data rate and is backward compatible with GPRS/EDGE (GSM) technology.

GR-5 Features P/N: 7010-1004 2




Unpacking Your Receiver Kit

This section describes the documentation, standard kit componentsl, and accessories (depending on your purchase) that
accompany your receiver. When you unpack your receiver kit, verify you received the items listed in this section. If any items
are missing or damaged, contact your Topcon dealer or Topcon technical support. See “Getting Technical Support” on page 6.
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Standard Kit Components'

Figure 1: Standard System Components that are Included with Your Receiver

1. Components in standard kits may differ based on your region. Contact your local Topcon dealer to inquire about items included in your
regional standard kit and accessories that are available with the receiver.

Unpacking Your Receiver Kit P/N: 7010-1004 3




The GPS+ Software CD includes USB drivers, which you need to install to use the USB port for
= communications.
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Accessories

Topcon offers a wide variety of accessories® (see Figure 2)
specially designed to improve system flexibility and job site
efficiency. For more details on the optional accessories
available for GR-5, contact your Topcon dealer.

Figure 2: Receiver Accessories

1. For more detailed information, see “Accessories” on page 4.

Unpacking Your Receiver Kit P/N: 7010-1004 4




Technical Documents

The GR-5 Manual CD includes two manuals (listed below) that help you set up and use your new receiver quickly and efficiently.
® GR-5 Operator’s Manual — An on-screen help document that contains detailed information on how to use your new
receiver.

® Topcon Receiver Utility (TRU) Online Help— An on-screen help document embedded in the software that contains
detailed information on how to use the TRU software. For more information about the TRU software, see “Using Topcon
Software With Your Receiver”.

Using Topcon Software With Your Receiver
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Use the GR-5 receiver in conjunction with the Topcon Receiver Utility (TRU) and MAGNET Field™ or Pocket-3D applications for
a precision positioning solution. Topcon software enables you to configure the receiver and other external devices, manage files,
collect data, and perform survey and construction work flows.

The Topcon Receiver Utility (TRU) is a hardware configuration software for receivers and peripheral devices. You can install it on
desktop computers and data controllers. This program is provided on the GPS+ Software CD that accompanied your receiver. A
TRU help document is provided on the GR-5 CD.

Topcon’s MAGNET Field™ software for data controllers provides real-time communication, cloud storage, data collection and
exchange, and field solutions, such as topo, staking, roads, calculations, and more.

Pocket-3D is a program that runs on data controllers with Windows CE® and mobile platforms. Pocket-3D simplifies data
collection, allowing you to check cuts and fills, layout points and survey all or part of the job site quickly and efficiently. Contact
your Topcon dealer for more information about Topcon field data collection software for the surveying and construction
markets.

Technical Documents P/N: 7010-1004 5




Getting Technical Support

Before contacting a Topcon customer representative about any problems with the receiver, see “Troubleshooting” on page 65
for some solutions that may fix the issue.

Contact your local Topcon dealer or visit the Topcon Total Care Web site (www.topconcare.com) for technical support.
///,@ For quick and effective support, provide a detailed description of the problem.

When contacting Topcon for technical assistance, provide the following information for better and faster service:

1. A description of the following:
— Field operation that was being performed when the problem occurred
— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the problem
— Problem occurrence frequency or patterns

2. Receiver information and configuration settings. For receiver information, click Information in TRU, select Save to
File, enter a file name, and save it to the computer.

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory and
storage capacity, etc.

Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Getting Technical Support P/N: 7010-1004
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Website

The Topcon website provides current information about Topcon’s line of products. The support area of the website provides
access to Topcon field and office software, manuals, frequently asked questions, and so forth. To access the Topcon website,

visit www.topconpositioning.com.
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The Topcon’s TotalCare web site also provides complete support, such as news, updates, reminders, training, live Webinars, and
customer service to help you get the information you need. Visit www.topconcare.com.
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Getting Acquainted

The GR-5 receiver enclosure is fully sealed and incorporates the GNSS receiver board, antenna, batteries, memory storage,
and wireless communication device.

Receiver Overview

The upper portion of the receiver contains the GNSS antenna, which is enclosed by the radome and securely surrounded by
a shock-absorbing rubber bumper. The receiver’s magnesium alloy lower enclosure features an easy-to-operate display
panel, detachable batteries, quick release mounting socket, and data ports.

The GR-5 receiver has a highly-visible display panel with single-button operation. The display panel enables you to view the
receiver’s operational status. For more information, see “Display Panel Operations” on page 19.

You can locate regulatory and product identification information on the two receiver labels, which are located inside of the
battery compartments. The product identification label contains the serial number and part number.

Getting Acquainted P/N: 7010-1004 8



Cables

The GR-51 package includes a power supply cable, a USB cable, and a power adapter. Table 1 describes the cables included
with your receiver, depending on your regional standard kit configuration. Make sure to contact your local Topcon dealer
to inquire about standard items included in your receiver kit.

until it clicks to secure the cable in place. To disconnect the cable, turn the lock counter-clockwise, and then

Align the keyways when connecting the power/serial cable to the receiver port. Turn the cable lock clockwise
gently remove the cable.
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Table 1. Receiver Cables

Cable Description Cable lllustration

Power Cable

Connects the power supply unit to a grounded outlet.
U.S.: p/n: 14-008052-01

Europe: p/n: 14-008054-01

Australia: p/n: 14-008053-01

Brazil: p/n:1000475-01

1. Components in standard kits may differ based on your region. Contact your local Topcon dealer to inquire about items included in your regional
standard kit and accessories that are available with the receiver.

Cables P/N: 7010-1004 9




Cables

Table 1. Receiver Cables

Cable Description

Cable lllustration

USB Cable

Connects the receiver to an external device (controller or
computer) for data transfer and receiver configuration.

p/n 14-008070-01

Receiver Power/Charging Cable

Connects the receiver and the power supply unit via SAE
connectors for battery charging.

p/n 14-008016-03

Serial Cable

Connects the receiver to an external device (controller or
computer) for data transfer and receiver configuration.

p/n: 14-008005-03

P/N: 7010-1004
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Accessories

Topcon offers a wide variety of accessories specially designed to improve system flexibility and job site efficiency. For more
details about the available accessories, contact your Topcon dealer.
* Power Supply Unit (p/n 22-034101-01): charges the detachable batteries when connected to a grounded outlet. This

unit converts the alternating current (AC) normally supplied from an electrical outlet to a direct current (DC) used to
charge the batteries and/or power the receiver.

The power supply unit should only be used for charging the batteries. Do not use as a power source
during surveying.

The power supply unit can either be connected to the charging cradle or directly to the receiver. For details, see the
power related sections in “Power Supply Unit” on page 31.

* The Modem Antenna: The Spread Spectrum (FH915+) antenna is a reverse polarity TNC RF connection (p/n 30-030012-
01) and a UHF antenna is a BNC connection (p/n 30-070003-01 UHF 410-440 or p/n 30-050503-01 UHF 450-470).

* The 2m Fixed Height Tripod and Pole: A heavy duty tripod (22-050501-01).

* The universal tribrach and tribrach adapter® (p/n 22-006008-01 and p/n 22-006009-011): are used to level the tripod
and secure the receiver or antenna to the tripod.

* The precision tribrach adapter: is used to precisely center, align, and level the tripod over a point. The horizontal spacer
(p/n 60419) inserts into the precision tribrach and allows the receiver to sit securely on the precision tribrach.

1. The universal tribrach and tribrach adapter is not needed when using the heavy duty tripod (22-050501-01).

Accessories P/N: 7010-1004
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* The quick disconnect adapter (p/n 02-850905-01): connects to the range pole for the receiver to slip into the top. Using
the side clips, the receiver can be quickly connected to/disconnected from the range pole.

* A hand-held controller: allows the GR-5 Base and Rover systems to be configured and monitored directly in the field.
You can use the Topcon Receiver Utility (TRU) to configure the receiver and any Topcon field data collection software.

* MAGNET and Pocket 3D Software: can be used to operate the receiver. See reference manual of TRU or Field data
collection software for details on set up and operation.

* The ODU-to-alligator clips cable (p/n 14-008097-01LF): connects the charging cradle or receiver to an auxiliary battery
for powering the receiver during survey operations.

* The AA battery pack: holds four AA batteries to provide a portable backup power source for the receiver. Due to
variances in AA battery capacity, and the mode of the receiver and type of modem, the amount of time the receiver is

powered varies.

Do not use rechargeable AA batteries.
Do not use the AA battery shell when the radio modem is in transmitter mode.

* (Cradle-to-receiver charging cable (p/n 14-008072-01 (1.5m long) p/n 14-008072-02 (0.5 m long): Connects the receiver
to the charging cradle for external power.

* Battery Recharger (01-050911-01): Charges the batteries. See “Charging the Batteries” on page 31.

Q)]
0
~+
=
3
09
>
0
e
c
=,
3
=+
5
o

Accessories P/N: 7010-1004 12




Batteries

The receiver comes equipped with two detachable, rechargeable batteries for powering the receiver. For more
information about using the batteries, see “Managing Power” on page 30.

Detachable
Battery
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Detachable
Battery

Figure 3: GR-5 Detachable Batteries
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Data and Power Ports

The GR-5 has the following three ports: a

® USB-rimmed in yellow; used for high-speed data
transfer and communication between the receiver
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and an external device. The body of the connector ) > ©
on the corresponding cable is yellow. usB (ilenalt(l) P(omg;r =
. . . ellow ac re
® Serial Port — rimmed in black; used for v \ ) L = =
communication between the receiver and an
external device. =N
/ o
®* Power - rimmed in red; used to connect the " w 31
receiver to an external power source. This port can R
also be used to charge the batteries. The body of
the connector on the corresponding cable is red.
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External Radio Antenna Connector

The radio antenna connects to the external antenna connector on the GR-5 radome (Figure 4). The radio antenna uses a
reverse polarity TNC or BNC connection depending on the installed radio modem.
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External
Antenna
Connector

Figure 4: GR-5 Radome and External Antenna Connector
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Bottom Connector

The bottom connector (Figure 5) connects the receiver to either astandard 5/8" thread pole/adapter or the quick
disconnect. The quick disconnect adapter (p/n: 02-850905-01) connects to the range pole for the receiver to
dip into the top. Using the side clips, the receiver can be quickly connected to/disconnected from the range
pole.

Quick Disconnect
Adapter
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Bottom Connector
for Standard Setups

Figure 5: GR-5 Quick Connector
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SD/SDHC and SIM Card Slots

The SD/SDHC and SIM card slots are located under the battery compartments near the base of the dome. For more
information about the SD/SDHC card, see “Memory” on page 59. For more information about SIM cards, see “SIM Card
Slot” on page 18.
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Figure 6: GR-5 Card Slots
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SIM Card Slot

The SIM card slot is located to the right of the LED Display Panel inside the battery compartment. It enables you to install
a standard SIM card into the receiver. Once installed, the SIM card provides a unique identification for the receiver’s HSPA
module and enables the receiver’s HSPA functionality based on the subscribed services (the receiver board accesses the
HSPA module, which accesses the SIM card). The SIM card usually remains inside the receiver. You can access the HSPA
module, with the SIM card installed, via TRU for configuration purposes. A SIM card can be purchased from a local cellular
provider.
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The GR-5 receiver, equipped with a CDOMA module, does not require a SIM card and is only approved to work
@@ on a Verizon® wireless network. Note the MEID # printed on the GR-5 unit or extracted from TRU, and call
Verizon to activate service on the CDMA module. installed on the GR-5 receiver.

SIM Cards

The SIM card must have GPRS support to communicate over a TCP/IP network.

Installing the SIM Card

1. Make sure the receiver is turned off.
2. Remove the detachable battery to the right of the LED Display panel.

3. Carefully insert the SIM card, label-side up, into the SIM card slot located at the top of the battery compartment.
Once the receiver is turned on, the receiver board will detect the SIM card, and it will be ready to use as needed.
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Display Panel Operations

The LED display panel (Figure 7) enables you to control receiver power and data recording. The LEDs display the status of
the satellite tracking, recording/memory capacity, Bluetooth connections, and batteries. This chapter describes the different
LED blink patterns and what they mean.

REC RX TX
STAT BT
aly
| W Y I |
/
0 0

FUNCTION

Battery Battery

Power FUNCTION | L
Button Button | |

Figure 7: LED Display Panel
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Power Button

The power button turns the receiver on and off. When turning the receiver on, press the Power button until the LEDs
briefly flash. When turning off the receiver, press the Power button until the LEDs go out.

Press the power
button for about 1
second to turn the

receiver on/off.
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Power _j

Button

Figure 8: Power Button Functions

Receiver Status LEDs

There are four status LEDs to provide you information about the battery life, tracked satellites, memory capacity, and
Bluetooth wireless connectivity. This section describes the color and behavior of each LED.
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STAT LED

The tracking status LED displays the status of tracked satellites when the receiver is on.
Table 2. Status LED Patterns

LED Color Description

One blink per tracked GPS satellite.

One blink per tracked GLONASS satellite.

One blink means no satellite is being
tracked.
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REC LED

The recording LED indicates if data is being written to memory and warns if memory is available for recording. For a
description of the REC LED status when using the FUNCTION button, see Table 7.

Table 3. Recording LED Patterns

Display Description

o> Green Blink: File logging is in progress. Each blink
indicates data is being written to the SDHC card.

Solid Orange: The receiver is changing modes.
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Table 3. Recording LED Patterns

Display Description

Orange Blink: The file system is not accessible.

)
P Solid Red: A fault condition with the receiver (no
more memory, no SDHC card inserted, a

hardware problem, or an improper OAF.

@g For more information on REC LED patterns, see “FUNCTION Button/Logging Data” on page 26.
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RX TX LED

This LED displays the status of the modem. Table 4 describes the LED colors and patterns for the different modems
available for the GR-5 receiver.

Table 4. GR-5 LEDs

FH915/Digital Il

No Light Modem is turned Off
Green Flashes (green LED, off, green LED) Modem is in receiver mode
P/N: 7010-1004 22
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Table 4. GR-5 LEDs

A radio link has been established; modem is ready to receive
data

Solid Green

Solid Green plus yellow (green LED, green LED + . o . .
Modem is receiving data (Yellow during actual reception)

red LED)
Solid Red Modem is in transmitter mode
Red Flashes (rapid red LED, off, red LED) A fault condition has been detected

Red then Green (Red LED, off, green LED, off) Modem is in command mode

GSM/HSPA
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Solid Yellow (Red LED + Green LED) Modem is initializing

The modem is on, registered on the network, and is waiting for
Green Flashes

incoming calls

Solid Red A connection had been established
Green Blinks (DUHF Il or SpSp) The modem is in direct control mode (Daisy Chain)
Yellow flashes (green LED + red LED, off) an error has occurred (initialization error, wrong PIN code etc.)
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Bluetooth LED

The Bluetooth LED displays the status of the Bluetooth activity. Table 5 describes the activity.
Table 5. Bluetooth LED Patterns

LED Color Description

Blue Blink: Bluetooth is on and waiting for a connection.

Blue Solid: A single Bluetooth connection is established.

No light: Bluetooth is turned off.
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Battery LED

The Battery LED indicates the remaining charge of each detachable battery. When an external power source is utilized,
the Power button LED turns solid green and begins to blink if the batteries begin to charge. See Table 6 for more

information.
Table 6. Battery LED Patterns
LED Color Description
THE RECEIVER IS ON; USING BATTERY POWER
o> Slow Green Blink (5 sec.): The charge is greater than 85 percent.
> Slow Orange Blink (5 sec.): The charge is intermediate.
P/N: 7010-1004 24
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Table 6. Battery LED Patterns

LED Color Description

Slow Red Blink (5 sec.): The charge is less than 15 percent.

\

EXTERNAL POWER IN USE(POWER BUTTON LED SOLID GREEN);BATTERIES ATTACHED2P

Fast Green Blink (1 Sec.): The internal batteries are at greater than 85% capacity; the batteries
are being charged.

Fast Orange Blink (1 Sec.): The internal batteries are at greater than 15% capacity; the
batteries are being charged.

000

Fast Red Blink (1 Sec.): The internal batteries are at less than 15% capacity; the batteries are
being charged.

a. The receiver is on or off.
b. You can also charge the batteries using the battery charging cradle. See page “Battery Charging Cradle” on page 32.
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FUNCTION Button/Logging Data

ThIS buttgn switches the receiver bet'ween Press the FUNCTION =
information modes and post-processing button for 1-5

modes, starts/stops data recording, and seconds to start/stop

changes the baud rate of the serial port to data logging. F tocost)| O

9600. The FUNCTION button enables you to
turn data recording on or off. See Table 7 to
learn how to use the FUNCTION button.

O} 0]

FUNCTION

Each time data recording is turned off or on,
either a new file opens or data appends to a
particular file.

FUNCTION

Button
———
\”@J

Figure 9: FUNCTION Button
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Table 7. FUNCTION Button Operations and REC LED Status

FUNCTION Key REC LED Status

When data recording is off, and the FUNCTION key is...

FUNCTION Button/Logging Data P/N: 7010-1004 26




Table 7. FUNCTION Button Operations and REC LED Status (Continued)

Not pressed

FUNCTION Key REC LED Status
No light No data recording.
Orange blink Internal file system test in progress.

Red

No free memory; hardware problem with data recording.
No SDHC card.

Pressed for <1
second

If FUNCTION key mod

e is “LED blink mode switch”

Orange

Release to change information mode.

If FUNCTION key mod

e is “Occupation mode switch”

Orange

No function.

Pressed for 1-5
seconds

If FUNCTION key mod

e is “LED blink mode switch”

Green

Release to start data recording (post-processing occupation
mode undefined).

If FUNCTION key mod

e is “Occupation mode switch”

seconds

Green Release to start recording (Kinematic or Static post-
processing occupation mode).
Pressed for 5-8 Red Release to turn serial port A baud rate to 9600 bps.

FUNCTION Button/Logging Data

P/N: 7010-1004
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Table 7. FUNCTION Button Operations and REC LED Status (Continued)

FUNCTION Key REC LED Status
Pressed for > 8 No light No function.
seconds
When data recording is on, and the FUNCTION key is...

Not pressed

Red

No free memory; hardware problem with data recording.

If FUNCTION key mod

e is “LED blink mode switch”

Green

Data recording started (post-processing occupation mode
undefined).

If FUNCTION key mod

e is “Occupation mode switch”

Green Data recording started (Kinematic post-processing
occupation mode).
Orange Data recording started (Static post-processing occupation

mode).

Pressed for <1
second

If FUNCTION key mod

e is “LED blink mode switch”

Orange

Release to change information mode.

If FUNCTION key mod

e is “Occupation mode switch”

Orange

Release to toggle between Static and Kinematic post-
processing modes.

FUNCTION Button/Logging Data

P/N: 7010-1004
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Table 7. FUNCTION Button Operations and REC LED Status (Continued) O
=
FUNCTION Key REC LED Status T
Q
Pressed for 1-5 No light Release to stop data recording. <
seconds v
Q
Pressed for 5-8 Red Release to turn serial port A baud rate to 9600 bps. 8
seconds -
Pressed for > 8 No light No function (data recording still on). o
seconds ()
=
Q
=
@)
=)
n
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Managing Power

This chapter describes how to power the receiver, charge the detachable batteries, and use an external power source.

Turning On/Off the Receiver

To turn on the receiver, press and hold the power button for more than one second until the LEDs briefly flash. When the
receiver is turned on, the receiver’s channels initialize and begin tracking satellites from multiple constellations (depending
on the receiver’s supported features and current OAF).

To turn off the receiver, press and hold the power button for more than one and less than four seconds (until both the STAT
and the REC LEDs are off).

placed in storage for a long period, such as a few months, the batteries may become fully discharged. You will

The receiver will draw a small amount of power from the batteries when it is turned off. If the receiver is
@g
need to use an external power supply or recharge the batteries before use.

Powering the Receiver

The receiver is powered by the detachable, rechargeable batteries or an external power source connected to the power
port. If an external power source is connected, the receiver draws power from it over the battery.
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Powering the Receiver P/N: 7010-1004

Detachable External Batteries

Each detachable battery provides between 5 and 10 hours of operation, depending on the receiver mode.

To check the status of the detachable batteries, view the BATT LED or check the status using available Topcon software.

Charging the Batteries

The batteries are shipped from the factory without power. Fully charge the batteries before surveying. You can use the
power supply unit or the battery charging cradle to charge the batteries.

lamod 8uiSeueypy

Power Supply Unit

The power supply unit (p/n 22-034101-01) charges the external batteries when connected to a grounded outlet. This unit
converts the alternating current (AC) normally supplied from an electrical outlet to a direct current (DC) used to charge
the batteries and/or power the receiver.

Do not expose the power supply to rain or snow. It should only be used for charging the batteries.

The power supply unit is designed for indoor use only. Do not use in a damp or a wet environment.
@ Do not use as a power source during surveying.

You can connect the power supply unit to the charging cradle or directly to the receiver. See “Power Supply Unit” on
page 32. The power supply has the following specifications:

® input voltage — between 100 and 240 V AC
* frequency of input power — between 50 Hz and 60 Hz
* output voltage— 12V DC@2.5 A (30 W)

31
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To Receiver

Figure 10: Power Supply Unit

Battery Charging Cradle

The battery charging cradle (Figure 11) connects to a standard power outlet using the power adapter cable and power
cable/power supply unit.

The charger has two ports, one button, and three LEDs.

* The two ports connect the charger to either a receiver or an external power source. The ports charge or drain the
batteries simultaneously.
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® The STATUS button activates the battery LEDs.
Press STATUS to display the amount of charge for the corresponding battery.

* The two battery LEDs display the percentage of charge in the attached battery:
— A green light indicates a charge greater than 85%.
— An orange light indicates an intermediate charge.
— Ared light indicates a charge of less than 15%. Recharge or replace the battery as soon as possible.
* The power LED lights up when the charger is connected to an external power source; such as an electrical outlet or
another power source (12 volt battery).

lamod 8uiSeueypy

Two power in/out ports

STATUS
£5 TOPCON
©

Battery Button Battery

®
\—— [S)
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(@ STATUS @ N N n N

Power

9

Figure 11: Battery Charger Cradle with Batteries
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You can also attach the battery charger to a tripod, a belt, or an RTK pole to provide external power to the base station or
rover.

Before using the GR-5, fully charge the batteries for maximum operating time.

Battery Charging Temperatures

Charge the batteries only in temperatures between 32°F (0°C) and 113°F (45°C).
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An optimal charging temperature is between 50°F (10°C) and 77°F (25°C). If possible, charge the
batteries within this temperature range.

Charging Procedure

There are two ways to charge the receiver’s detachable batteries:

* while they are attached to the receiver

* while they are attached to the charging cradle
If the batteries are attached to the receiver or to the charging cradle, in approximately six hours the batteries will be
simultaneously fully charged.

The Li-lon batteries used in the battery packs should run at no less than 80% capacity after 500 charging cycles. You do
not need to drain these batteries before recharging.
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To charge the batteries using the power supply unit:

1. Plug the receiver-to-SAE power cable into the
receiver’s power input port.

2. Connect the receiver-to-SAE power cable and the
power supply-to-outlet cable to the AC adapter.

3. Plug the power supply-to-outlet cable into an
available outlet. The batteries are fully charged
after approximately 6 hours.
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To charge the batteries using the charging cradle:

1. Remove the batteries from the receiver and insert
them into the charging cradle.

2. Connect the power cable to the power supply unit.

3. Connect the SAE connectors on the power adapter
cable and power supply unit.

4. Connect the power adapter cable to one of the
ports on the charging cradle (either port will charge
both/either battery).

5. Plug the power supply to an available outlet. The

batteries are fully charged after approximately 6
hours.

Figure 12: Charging Batteries
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Leaving the Batteries on Charge
The batteries can be safely left in the receiver or the charging cradle once charging is complete. Doing so will not
overcharge or damage the batteries.

The batteries can also be attached/detached to/from the receiver or charging cradle at any time without harming the
batteries, the receiver, or the cradle. When returning the batteries to the receiver or cradle, charging is automatically

resumed.

lamod 8uiSeueypy

Attaching the Batteries

To attach the batteries to the GR-5 (Figure 13):

1. With the battery slightly tipped, place the bottom
of the battery into the bottom of the battery
compartment.

2. Gently push the top of the battery into the battery
compartment until it snaps into place. Make sure
that the clip at the top of the battery completely
snaps into place.

Figure 13: Inserting the GR-5 Batteries
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Detaching the Batteries
To detach the batteries from the GR-5, so that they can be charged or replaced:
Using the clip at the top of the battery, gently pull down and out to detach the battery from the receiver (Figure 14).
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Figure 14: Detach the GR-5 Batteries

Assembling the AA Battery Shell
To assemble the AA battery shell to the GR-5 (Figure 15):

Do not use rechargeable AA batteries.
Do not use the AA battery shell when the radio modem is in transmitter mode.

1. Slide the back cover of the AA battery shell down and lift off.

Powering the Receiver P/N: 7010-1004 37




2. Insert four AA batteries as shown on the inside of the shell (and in Figure 15 below).
* The batteries on the left lay with the positive end towards the bottom of the shell.
* The batteries on the right lay with the positive end towards the top of the shell.

3. Replace the back cover of the shell.

lamod 8uiSeueypy

Figure 15: Remove Cover and Insert AA Batteries

4. Insert the AA battery shell into the battery compartment of the receiver as shown in Figure 13 on page 4-36.

Surveying While Charging
The user can execute any kind of surveying while charging the internal batteries attached to the GR-5 without degradation
of performance.

While charging, make sure the air temperature is between +32 °F (0 °C) and +113 °F (+45 °C). This is
important to prevent serious damage to the batteries, the receiver or injury to persons.
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Changing the Batteries while Surveying

It is safe to change a depleted battery with a fully charged one while surveying (i.e., on the fly) without turning off the
receiver. Before doing this, make sure the other battery has enough charge to power the receiver while changing the
depleted battery. The surveying will not be disrupted. If needed, repeat this procedure for the second battery.

Using an Auxiliary Power Source
In addition to the detachable batteries, you can connect the receiver to an external power source, such as a vehicle battery

with 9 to 21 VDC, to operate the receiver and for continuous use of the receiver if the detachable batteries become
discharged.

@ Power input greater than 21 VDC could damage the receiver.

To connect the receiver to an auxiliary battery (Figure 16 on page 4-40):

<
Q
-]
Q
Q,
-]
0Q
av)
]
2
0]
=i

Use the ODU-to-alligator clips cable (p/n 14-008097-01LF) to directly connect the auxiliary battery and the receiver’s
power port (without SAE).

When powering the receiver using external batteries, set the charger mode to Off; otherwise, the
detachable batteries will also charge, causing operation time to decrease.

1. Connect the ODU-to-alligator clips cable to a 12-volt battery.
2. Connect the ODU-to-alligator clips cable to the receiver’s power port.
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3.  Turn on the receiver.

From Receiver to Auxiliary Battery
Using ODU-to-Alligator Clips Cable
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Figure 16: Connect an Auxiliary Battery and the Receiver

Asingle external 12V, 2.3 A*h battery should run the receiver and modem for about 9 hours and the receiver for 13 hours.
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To connect the receiver to the charging cradle (Figure 17):

The charging cradle with extra batteries hooks onto a tripod or belt for a convenient power supply for the receiver. The
part number for the receiver-to-charger cradle cable is 14-008072-01 or 14-008072-02.

1. Connect one end of the cradle-to-receiver cable to the charging cradle.
2. Connect the other end to the power port on the receiver.
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The Batteries in the Charging Cradle do
not Charge the Internal/Detachable
Batteries. The Charging Cradle Powers
the Receiver

T4

4 ' 1

Figure 17: Connect the Charging Cradle and Receiver
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Insufficient Power

If the batteries become fully discharged and an external power supply is not connected, the receiver will shut down and
automatically save recorded files. To avoid disruptions, check the BAT LED on the display panel for the battery charge
status. See “Battery LED” on page 24 for more information.

If the receiver shuts down due to insufficient power, the receiver and all communication ports become de-activated.

To restore power to your receiver and turn it back on, do one or all of the following:
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® Recharge the batteries.
* Make sure the power cable is correctly connected to the receiver’s port.
a. Align the keyways when connecting the power/serial cable to the receiver port.

b. Turn the cable lock clockwise until it clicks to secure the cable in place.
c. Todisconnect the cable, turn the lock counter-clockwise, and then gently remove the cable.
® Connect the receiver to a different power source.

-~ Power supplied to the receiver should match the specifications provided by Topcon on the product. Failure to
= comply with these specifications may damage the receiver. See “Specifications” on page 75.
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Configuring the Receiver

The sections in this chapter describe receiver options, and how to load a new Option Authorization File (OAF), update firmware,
and perform a factory reset. To do this, you will need to use the Topcon Receiver Utility (TRU) software that was supplied on the
GR-5 CD. For information about installing the software, see the Topcon Receiver Utility (TRU) Online Help embedded in the
software.

Viewing Receiver Information

In the Topcon Receiver Utility (TRU), the Receiver Info window displays basic receiver information, such as hardware and firmware
versions, RAM size, receiver ID, serial number, etc.

To open the Receiver Info window:

Connect the receiver to a computer and open TRU.

In TRU, connect to the receiver.

Click Device » Application Mode » Receiver Managing.

Click Device » Connect.

In the Connection Parameters window, select the correct serial port, and click Connect.

ok LN R

In the TRU main window, click the Information icon. The Receiver Info window (Figure 18) appears.
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Figure 18: TRU — Receiver Info

The GR-5 receiver, featuring Vanguard technology, is referred to as the GR-5+ to differentiate from the GR-5
= receiver with an older receiver board.
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Loading New Firmware

Receiver board firmware is released as a compressed file that you download and decompress. This file contains the following
two files:

® ramimage.ldr — the Receiver board RAM file
® main.ldp — the Receiver board Flash file

To upload firmware files to the receiver:

1. Connect the receiver to a computer using the Power and Serial cable receiver accessory (p/n: 100182-01).
2. To connect to the receiver in TRU:

a. Click Device » Application Mode » Firmware Loader.
b. Click Device » Connect.

c. Inthe Connection Parameters window (Figure 19), select Serial Port and the port name, and then click
Connect.
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Figure 19: Connection Parameters Window

3. Click the Firmware Loader icon in the TRU main window. The Firmware Loader window (Figure 20) displays.
This window enables you to upload firmware files to the connected receiver.

Make sure Receiver/Modem/Bluetooth is selected in the Device field.

(Recommended) Select Soft Break as the Capture Method.

Browse for and select the receiver board’s RAM and Flash files (Figure 20).

o v
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Figure 20: Upload Firmware Window

7. Click Start to upload the selected files.
8. Click OK to continue uploading new firmware to the receiver (see Figure 21).
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Figure 21: Finishing Firmware Upload
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About the OAF

Topcon issues an Option Authorization File (OAF) to enable the specific options that you purchased. Topcon’s OAF system allows
you to customize and configure the receiver according to your particular needs, therefore purchasing only the options you
require.

The GR-5 receiver typically ships with an OAF as per initial purchase of the receiver kit configuration. There are several upgrade
options available with the receiver that can extend the receiver’s functionality to better suit your job requirement. Examples of
upgrade options are listed below:

® GLONASS L1, L2 signal tracking
® GPS L5 signal tracking
® RTK and update rate 20, and 50 Hz (10 Hz standard)
Contact your Topcon dealer or a representative for a complete listing of available options and pricing information.

Checking the Receiver’'s OAF

To use TRU to view the status of the receiver’s options:

1. Connect the receiver to a computer and open TRU. See the Topcon Receiver Utility (TRU) Online Help for more
information about connecting the receiver to a computer.

2. InTRU, connect to the receiver.

3. Click the Options icon in the main window. The Receiver Options window (Figure 22) displays, so you can view
the current authorization options and upload new ones.
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Receiver Options

=E——

Option Name
GPS
Glonass
L1

L2
Cinderella

Position Update Rate, Hz
Raw Data Update Rate, Hz
Code Differential Base
Code Differential Rover
RTK Base

RTK Rover, Hz

Memory, MB

Co-op Tracking

1-PPS Timing Signal

Event Markers

In-Band Int. Rejection
Multipath Reduction

Refresh |

Current Purchased
Yes Yes

Yes Yes

Yes Yes

Yes Mo

Yes Yes

100 20

100 20

Yes Mo

Yes Mo

Yes Mo

100 Disabled
Mot supported 0

Yes Mo
Double Double
Double Mo

Mot supported Disabled
Yes

Leased
Yes
Yes
Yes
Yes
Yes
100
100
Yes
Yes
Yes
100
1,024
Yes
Double
Double
Enabled Outside USA

hi Yes
Upload OAF |

Exp. Date
9/24/2011
9/24/2011
9f24/2011
12f31/2011
9/24/2011
12/31/2011
12f31/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011
9f24/2011
9/24/2011
9/24/2011

~

Save to File

Loading an OAF

Figure 22: Receiver Options

Topcon dealers provide customers with OAF files. For any OAF related questions, e-mail Topcon at options@topcon.com and

include the receiver’s ID and serial number. To obtain these numbers, see “Viewing Receiver Information” on page 43.

To load a new OAF:

1.
2.

About the OAF

Follow the steps in “Checking the Receiver’s OAF” on page 49.
Click Upload OAF on the bottom of the Receiver Options window (see Figure 22).

P/N: 7010-1004
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3. Navigate to the location of the new Option Authorization File (Figure 23).
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Figure 23: Load OAF

4. Select the appropriate file, and click Open (Figure 23).
Topcon’s TRU initially checks to see if the selected file is compatible with the currently connected receiver. If you
chose afile not intended for this receiver, the Upload OAF window displays an error icon next to the Receiver ID and
disables the Upload the File to the Receiver button.
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Figure 24: OAF Compatibility Check
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5. Press Upload the File to the Receiver (Figure 24) to start loading the file.
If an OAF file is uploaded to the receiver, TRU will offer to reset the receiver to put new authorization options into
operation (Figure 25).

L]

Figure 25: Reset the Receiver

6. Click Yes.
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Performing a Factory Reset

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as ephemeris data
and receiver position. The NVRAM also keeps the current receiver’s settings, such as active antenna input, elevation masks and
recording interval, and information about the receiver’s internal file system. A factory reset clears the receiver’s NVRAM and
restores the receiver’s factory default settings.

Although a factory reset or clearing the NVRAM is not recommended as a common practice, there are times when it can
eliminate communication or tracking problems.

After a factory reset, the receiver requires time to collect new ephemerides and almanacs (around 15 minutes).

A factory reset will not delete any files already recorded in the receiver’s memory, and the NVRAM keeps information about the
receiver file system.

There are two ways you can perform a factory reset: using TRU and using the LED display panel.

Using TRU to clear the NVRAM:

1. Connect the receiver to a computer, and open TRU. See the Topcon Receiver Utility (TRU) Online Help for more
information about connecting the receiver to a computer.

2. InTRU, connect to the receiver.
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3. Click the Tools icon in the main window.

The Tools window appears, enabling you to reset the receiver and clear the NVRAM.

D

Figure 26: Tools Dialog Box

4. Click Factory Reset, and click Yes to continue.

Using the LED display panel

Press the Power button to turn off the receiver.

Press and hold the FUNCTION button.

Press and hold the Power button for one second, and then release it while continuing to hold the FUNCTION button.
Wait until the STAT and REC LEDs turn green.

Wait until the STAT and REC LEDs blink orange.

Release the FUNCTION button while the STAT and REC LEDs blink orange.

o Uk N R
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Field System Setup

This chapter describes the field setup of your new receiver, so it is ready for use as a Base, network, RTK Rover, or static data
collector.

Setting Up the Base Receiver

1. Install a heavy-duty tripod (p/n: 22-050501-01)
over a known point. You do not need a universal
tribrach and tribrach adapter when working with
this tripod.

2. Attach the antenna to the modem antenna
connector.

. . ; Heavy Duty Tripod
3. Level the tripod and tighten the screws. 1 eavy buty Tripo
4. Attach any other accessories as needed, such as a

back-up power supply.

GR-5 Receiver

5. Measure the height of the receiver from the
ground using the tape measure. See “Measuring
Antenna Height” on page 57.

6. View the LED display panel for the receiver’s
current status. See also “Display Panel Operations”
on page 19.
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Setting Up the Rover Receiver

1. If needed, attach the quick disconnect to the
bipod/range pole.

™ GR-5 Recevier
~

Use a bipod during post-process a
~ g surveys to ensure the \ Quick Disconnect (Optional)
= ; S~

antenna/receiver does not 5/8 inch Screw

move during data logging.
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2. Attach the receiver to the quick disconnect.
Make sure the receiver locks into place. D— Lock
3. If you are not using a fixed height rover pole,
measure the height of the receiver from the —T
ground. See “Measuring Antenna Height” on
page 57.
Attach the antenna to the antenna connector.
5. Press the power button to turn on the
receiver. The integrated wireless device in the
receiver turns on when the receiver is
powered. U
6. View the LED display panel for the receiver’s
current status. See also “Display Panel
Operations” on page 19.
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Measuring Antenna Height

The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates of the station marker,
specify the following:

® Measured height of the antenna above the station marker

* Method of measuring the antenna height

* Model of the antenna/receiver used

Any necessary antenna phase center adjustments, based on the antenna model, is automatically applied. This adjustment, when
combined with accurately measured height and measurement methods, allows for correctly computed reference marker

coordinates.
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To accurately measure the antenna height:

1. Measure the antenna height above the control point or marker, either the slant height or the vertical height.
You may either measure the vertical height to the Antenna Reference Point (ARP) located at the bottom of the
receiver at the base of the mounting threads, or measure the slant height to the Slant Height Measurement Mark
(SHMM) on the side of the receiver. For ARP and SHMM marks on the receiver, see Figure 27.

2. Record the antenna height, points name, and start time in the field notes.

Measuring Antenna Height P/N: 7010-1004 57




B

168mm
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B

A =ARP to edge = 79.0
B = ARP to corner = 97.5

% LV = Vertical Length
LS = Slant Length

Figure 27: Antenna Height Measurement Points
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Collecting Data

This chapter provides general information about memory, recording data, downloading data, and removing files to free up memory
space.

Memory

The GR-5 is equipped with an external SD/SDHC memory card slot. Although you may install an SD/SDHC card of any
memory size into the slot, the receiver recognizes up to 32 GB of memory. For specific information, see “SD/SDHC Card
Recommendations” on page 103. It is necessary to use recommended SD/SDHC cards to ensure accurate and reliable data
logging and minimize any occurrence of data loss, card initialization, etc. The Optional Authorization File (OAF) controls the
receiver’s memory capacity. As data is logged to the card, the REC LED displays the memory capacity status. See “REC LED”
on page 21 for more information. To access the raw data files on the memory cards, see “Managing Files” on page 64.

Collecting Data P/N: 7010-1004 59



~
ez

Memory

SD/SDHC Card

The SDHC card slot is located to the left of the LED Display Panel
inside the battery compartment and connects an optional
SD/SDHC card to the receiver board to provide memory. Once
installed, the SD/SDHC card usually remains inside the receiver.
You can access the data that resides on the SD/SDHC card via the
USB or serial port, or Bluetooth wireless technology (see
“Managing Files” on page 64). A secure digital card can be
purchased at a local computer supply store.

Installing the SD/SDHC Card Card Slot

. . for SDHC d
Make sure the receiver is turned off. (for card)

Remove the detachable battery to the left of the LED
Display panel.
3. Carefully insert the SD/SDHC card, label-side down, into the
card slot located at the top of the battery compartment.
Once the receiver is turned on, the receiver board will
detect the SD/SDHC card, and it will be ready to use as needed.

Always initialize the file system on the installed SD/SDHC card before the first use. The Initialization procedure
is described below.

P/N: 7010-1004
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Memory

Initializing the File System

The GR-5 supports a removable SDHC memory card to log raw data files. The memory card must be initialized before its
first use. Initializing the memory card while in the receiver ensures the card is formatted to the TPS proprietary file system
(TPFS). This file system allows the receiver to create, store, retrieve, delete, and restore raw data files.

It is also advisable to re-initialize the memory card periodically (e.g., quarterly). This erases any data on the card, checks
for bad blocks, and sets the card up afresh.

The user can use TRU to initialize the file system.

Initializing the File System Using TRU

Connect the receiver to a computer and run TRU.
Click the File Explorer icon to open the File Explorer screen.
On the Files tab, press and hold the right mouse button on the file line.

s wnN e

Click Initialize File System.

Initializing the file system of a connected receiver will erase all of the receiver’s data files. A warning message
will appear to confirm the operation.
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Setting Recording Parameters

The Topcon Receiver Utility (TRU) software enables you to set logging parameters, such as logging rate and types of messages,

in which to record data. This software is supplied on the GR-5 CD. See the TRU Online Help for more information. The GR-5 is
compatible with any Topcon field software for configuration and recording raw data.

Logging Rates

The amount of memory used to log data depends on the logging rate. For more information about setting logging rate
parameters, see the TRU Online Help.

Recording Data

You can log raw GNSS data to the receiver’s SD/SDHC card and use the Topcon Receiver Utility (TRU) or MAGNET Office™
software to download the files to a computer.

To start or stop recording data, use the LED display panel or TRU:

1. Pressthe Power button to turn on the receiver.
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Recording Data

Wait for the STAT LED to indicate satellites are being Press the EUNCTION

tracked. The STAT LED blinks green for GPS satellites and button for 1-5
amber for GLONASS satellites. A short red blink indicates seconds to start/stop
the receiver has not solved a position. Five or more data logging.

satellites provide optimal positioning.
To begin recording, press and hold the FUNCTION button,

and then release it (between 1 and 5 seconds) when the

REC (Recording) LED turns green. /® & @ @» > )
Make sure the REC light blinks green. This indicates that a (Funcrion)

file has opened and data collection has started. The REC

LED blinks each time data is saved to the SD/SDHC
memory card. If the REC light blinks red, the receiver has: FUNCTION

* ahardware problem Button
® no SD/SDHC card installed

® animproper OAF (See “About the OAF” on page 49)

You can also select File Explorer » Logs » Start in TRU to begin recording data.

When you have finished recording, press and hold the FUNCTION button until the REC LED turns dark. You can also

select File Explorer » Logs » Stop in TRU to end data recording.
To turn off the receiver, press and hold the Power button until all LEDs turn dark.

You can also log data using MAGNET Field software.
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Managing Files

Raw data is recorded as time-tagged measurements in a single raw data file. Each file is recorded to the receiver’s memory, and
automatically given a name and a *.tps file extension. You can then transfer a file of collected data can to a computer with file
managing software, such as the Topcon Receiver Utility (TRU), which is supplied on the GPS+ CD. These programs allow you to
use an automatic naming feature, enter file names, and delete files as necessary. For more information, see the TRU Online Help
embedded in the software.

Downloading and Deleting Files

After completing a survey, download data files to a computer or a controller for storage, post-processing, or backup. The
SD/SDHC cards hold a finite amount of files, so you will want to delete files to increase memory capacity.

When the memory is full, the receiver stops logging data, and the REC LED turns dark/off, indicating an error condition. Existing
data is not overwritten.

To delete raw data files from the receiver, use a USB, serial, or Bluetooth connection to download the files to a computer. In
TRU, you can select the files you want to delete from the receiver. See the TRU Online Help for more information.

Once a connection is established, you can download all or some files to a computer or controller and then use the File Explorer
feature in Topcon Receiver Utility (TRU) to manage the raw data files. For more information about using TRU to download or
delete files, see the Topcon Receiver Utility (TRU) Online Help embedded in the software.
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Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the hardware.

Check This First!

Before contacting your local dealer or Topcon Technical Support, check the following:

Check all external receiver connections carefully to ensure correct and secure connections. Double check for worn or
defective cables.

Check the receiver’s internal batteries for a full charge.

Check the power source for incorrectly connected cables, and ensure the power source is valid. See “Specifications” on
page 75 for external power requirements.

Check the software. Make sure the most current software version is downloaded onto the computer and the most current
firmware is loaded into the receiver. Check the Topcon website for the latest updates.

Check Topcon Technical Support (www.topconsupport.com) or Topcon Total Care (www.topcontotalcare.com) for the
latest updates.

Then, try the following:

Troubleshooting

Power on and off the receiver by pressing the Power button or by using TRU (Tools » Reset receiver).

P/N: 7010-1004 65



® Restore default settings by clearing the NVRAM. See “Performing a Factory Reset” on page 53. This restores the
receiver’s parameters to the factory default settings and erases the almanac and ephemeris files. This action does not
delete data files from the receiver memory.

If the problem persists, see the following sections for other solutions.
Powering Problems

The following are some of the most commonly encountered power problems.

The receiver does not power up
® The battery may be discharged.
— Charge the battery overnight. See “Charging the Batteries” on page 31.
* If you are using an external power source, the cable may be disconnected or damaged.
— Make sure the cable is securely connected and undamaged.
* The receiver may have a defective charger or defective battery.

— If, after changing the battery or connecting an external power source, the receiver still does not power up,
contact your local dealer or Topcon Technical Support for advice.
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Receiver Problems

The following are some of the most commonly encountered receiver problems.

The receiver cannot establish a connection to a computer or external controller

Cable specific problems:
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® The cable is not properly plugged in.

— Unplug the cable, then securely and properly reconnect it to the receiver.
® The cable is damaged.

— Use an undamaged cable. Contact a dealer to replace the cable.
® The USB driver is not installed.

— If you are using a USB cable connection, make sure the USB driver, included on the GPS+ Software CD, is
installed on the computer. You can also download the driver from the Topcon support Website at
www.topcontotalcare.com.

Generic problems:

* The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Online Help embedded in the software).

b. Click Receiver Settings » Ports.

c. Change the Input Mode for the port used for connection to cmd.
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The receiver does not lock on to satellites for a long period of time

* The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be on to track satellites).
— Order a new OAF with the desired options activated to enable or extend validity of the corresponding receiver
options. Contact a dealer or visit the Topcon website for details.
— Refer to the “Receiver Managing” chapter of the Topcon Receiver Utility (TRU) Online Help for a detailed
description of options.
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The receiver tracks too few satellites
* If the survey is conducted near obstructions (tree canopy, tall buildings, and so forth).
— Make sure the Multipath Reduction boxes have been enabled in the field data collection software.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Online Help embedded in the software).

b. InTRU, connect to the receiver.

c. Onthe TRU main window, choose Receiver Settings » Tracking » Adv tab. Make sure the C/A code
multipath reduction check box is selected.

® Move to an area free of obstructions, if possible.

The receiver cannot obtain Code Differential and/or RTK solutions
® Incorrect Base coordinates entered.
— Specify the correct coordinates for the Base station using TRU or another suitable field data collection software.
® There could be some obstruction to the connection.
— Clear all possible obstructions or relocate the Base so there is a “line-of-sight” path to the Rover.
® The corresponding receiver options may be disabled or expired.
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— Order a new OAF with the required options activated to enable or extend validity of the corresponding receiver
options.
— Refer to the Topcon Receiver Utility (TRU) Online Help for a detailed description of options.

® There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track at least
five common satellites.

— Check the elevation masks of the Rover and Base receivers; they should be the same. To do this, on the TRU
main window, choose Receiver Settings » Tracking » Obs.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.
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* Adiscrepancy exists between the differential standards used at the Base and Rover receivers.
— Ensure the Base and Rover receivers use the same corrections input/output format:
a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Online Help embedded in the software).
b. InTRU, connect to the receiver.
c.  Onthe TRU main window, choose Receiver Settings » Ports.
d. Double-click on the port to be configured and make sure the input mode of the Rover matches the format
of the Base output mode (i.e. RTCM3).
® Poor satellite geometry (PDOP/GDOP values are too high).
— Conduct the survey where satellite visibility is better (low PDOP value).
— Ensure the elevation mask is less than 10 degrees.
— Increase the PDOP threshold. To do this, on the TRU main window, choose Receiver Settings » Tracking » Obs.
® The elevation mask is above 10 degrees.
— Lower the elevation mask. To do this, on the TRU main window, choose Receiver Settings » Tracking » Obs.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
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® The modem battery is low.

* The specified baud rate is incompatible with the baud rates the modem supports. The baud rate is the rate at which the
receiver transmits differential messages to the modem and vice versa.

— Change the modem’s baud rate.
® The Base and Rover modems use different radio link parameters.

— Configure the Base and Rover radio modems according to the procedures listed in the TRU Online Help.
® The distance between the Base and Rover is too far.
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— Close the distance between the Base and Rover.
— Use repeaters to increase radio coverage.
* There may be a source of radio interference that disrupts radio communications.
— Change the RF channel (if possible).
— Removing the source of the jamming signal or relocate the radio antennas (if possible).

The receiver does not start logging data

* Make sure the recommended SD/SDHC card is being used and that the card is not damaged. See “SD/SDHC Card
Recommendations” on page 103.

* Make sure the SD/SDHC card is properly inserted.
* The receiver’s memory is disabled or expired.
— Make sure the memory option is enabled. For details, see the Topcon Receiver Utility (TRU) Online Help.
® The memory card does not have free space.
— Download and/or delete data files to free up space for new files. See “Downloading and Deleting Files” on
page 64.
—The file system is not initialized. Initialize the File System on the SD card using TRU. To do this, on the TRU main
window, choose File Explorer » Initialize File System.
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Bluetooth Problems

The following are some of the most commonly encountered error messages and other problems.

TRU error message: Can’t find receiver

® The receiver is turned off.
— Ensure the receiver has power and is turned on.
® Bluetooth is not turned on; the BT LED is off.
— Reset the receiver to the factory default settings by pressing the Power button for 10 to 15 seconds.
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—You can also turn on power to Bluetooth using TRU. To do this, on the TRU main window, choose Receiver
Settings » Bluetooth.

® There s interference.

— Move the receiver, controller, or computer to an unobstructed location.
® The receiver is too far away.

— Move the devices closer together.
® The receiver is already connected via Bluetooth to another device.

— Disconnect the receiver from the other controller or computer.
* The receiver port used for connection is not in Command mode.

a. Connect the receiver to a computer and open TRU (see “Connection” in the Topcon Receiver Utility (TRU)
Online Help embedded in the software).

b. Click Configuration » Receiver » Ports.
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c. Change the Input Mode for the Bluetooth serial port used for connection to cmd.
~ This is the most common cause for this error message. Use TRU to double check the settings for the
= connection port.

TRU error message: Open COM# port failed: Access is denied
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® Another application uses the computer port dedicated for connection.
— Close the application, and then re-connect.
— Connect the receiver via another, unused computer port.

After searching for available devices, none are discovered

® The receiver is not receiving power.
— Check that the receiver is getting power and is turned on.
— Check that the power cable is correctly attached to the port if one is being used.
— Unplug the cable, then securely and properly reconnect it to the receiver.
— If the power cable is damaged, contact a Dealer to purchase a new cable.

Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot connect to it

® Device security settings probably differ.
— Make sure the Bluetooth enabled devices use the same security settings.
® Bluetooth module settings may have changed.
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a. If the settings are changed for the Bluetooth module, remove it from the list of discovered Bluetooth
devices using the Bluetooth manager program (supplied with the device used to manage the receiver).

b. Repeat the search.
TRU Problems

The following is the most commonly encountered TRU problem.
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TRU cannot connect to the receiver
® The receiver is turned off.
— Ensure the receiver has power and is turned on.
® If using a cable, the cable’s connectors are improperly attached.
— Check that the cable connector is attached to the correct serial port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
® If using a cable, the cable is damaged.
— Use an undamaged cable.
— Contact a dealer to purchase a new cable.
* If using Bluetooth wireless technology, the incorrect port is selected.
— Use a computer or receiver that has Bluetooth wireless technology enabled/installed.

— Make sure the computer and receiver use the correct ports for communication. For the GR-5 receiver, this is
Bluetooth serial port A (btsp\a).
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Cleaning and Storing the Receiver

® Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.
* Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support
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If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact Topcon Customer Support.
For contact information, see “Getting Technical Support” on page 6.
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Specifications

This chapter provides specifications for the receiver and its internal components.

General Details

Table 8 lists the receiver’s general specifications.

Table 8. General Receiver Specifications

Physical

Enclosure Dust and water Ingress protected magnesium I-Beam housing

Color Topcon Yellow / Gray bumper

Dimensions (mm) 158.1 (w) x 253 (h) x 158.1 (d)

Weight 1.88 kg with batteries, 1.44 kg without batteries

Antenna Type Integrated Full Wave Fence Antenna™2 with Ground Plane and zero
center

Battery Two external, detachable

Controller External
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Table 8. General Receiver Specifications

Mounting 5/8-11, quick disconnect
Seals Silicon (molding in color)
Keys Two keys:
¢ Power — On/Off
¢ Function — start/stop data logging; switch information mode
LEDs Six LEDs:

STAT — satellite and receiver status

REC —record and data status

RX TX — modem status

BT — Bluetooth wireless technology connection status

BATT (x2) — battery status

Environment

Operating Temperature

-30°C to +50°C Base*
-30°C to +60°C Rover*
-30°C to +60°C Base**
-30°C to +70°C Rover**

0° to +45°C Charge mode*

* with detachable batteries
** with external power source

General Details
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Table 8. General Receiver Specifications

Storage Temperature -20°C to +35°C with batteries
-40°C to +75°C without batteries
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Humidity 100%
Ingress Protection Dust and water ingress protected (IP66)
Shock/Bump/Drop Rating IEC 60068-2-29

IEC 60068-2-27
2 m pole drop to concrete

Vibration Rating Compliance with MIL-STD 810F - 514.5 - Cat.24
Power

External Batteries Li-ion, 3900 mAh, 7.2 V; 2 batteries, detachable
Battery Size 132 x 55 x 35 (mm)

Battery Weight 220 g (1 battery)
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Table 8. General Receiver Specifications

Operating Time For the GR-5 with FH915+ Modem:
¢ Receive-only mode — 14 hours

Average with modem “on e Transmitting at 250 mW — 12 hours
and 20 SVs tracked.
e Transmitting at 1 W — 10 hours

Using new, fully-charged e GSM/GPRS in urban areas — 13 hours
batteries, operating at room | For the GR-5 with Digital UHF Il Modem:

temperature and e Receive-only mode — 14 hours
transmitting at 1 Hz rate.
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¢ Transmitting at 0.5 W — 10 hours
e Transmitting at 1 W — 8 hours
e GSM/HSPA in urban areas — 12 hours

For the GR-5 with Any Modem:
Modem off — 20 hours

External power 1 port

Input Voltage 9 to 21 V DC (for work)
10 to 21 V DC (for charge battery)
Maximum Charge Current <=2 Amp
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Table 8. General Receiver Specifications

Power Consumption ¢ Modem = off — 3.0W
FH915

”

Average with modem “on”
and 20 SVs tracked.

e Receive-only mode—-4.3 W
e Modem transmitting at 250 mW - 5.2 W

¢ Modem transmitting at 1 W — 7.6W
Digital UHF 11
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Using new batteries and
operating at room
temperature. * Receive-only mode —4.3 W

e Modem transmitting at 0.5 W —-6.4 W
¢ Modem transmittingat 1 W —-7.8 W

Battery Charge Connect the AC adapter to charge the internal battery.
Available run charge when connected to external battery.

Charging Time Approx. 6 hours for full charge

On-board Backup battery for timekeeping and almanac data storage;
minimum 10 years of operation
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Table 8. General Receiver Specifications

GNSS

Number of Channels 226-Channel Vanguard Technology™ with Universal Tracking
Channels

GPS: L1, L1C, L2, L2C, L5
GLONASS: L1, L2

Galileo: E1, E5a, E5b, AltBOC
BeiDou: B1, B2

SBAS: L1 C/A WAAS/MSAS/EGNOS

QZSS: L1 C/A. L1CS, L2C

Tracked Signalsb
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Tracking

Multipath Reduction Yes, code and carrier
PLL/DLL Settings Bandwidth, order, adjustable
SBAS WAAS/EGNOS/MSAS

Quartz Lock Loop (QLL) Protection against vibrations

General Details P/N: 7010-1004




Table 8. General Receiver Specifications

Data and Memory
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Memory Removable SD/SDHC

Data Update/Output Rate 1 Hz — 50 Hz selectable (10 Hz standard for RTK operation)
Real Time Data Output TPS, RTCM SC104 v 2., 3.x (including MSM); CM/CMR+
ASCIl Output NMEA 0183 version 2.x and 3.0

Communication

Optional Radio Type Integrated UHF/FH915
Base Radio Output 1.0 W, user selectable
Optional Cellular Integrated HSPA/CDMA
I/0 Communications Class 2 Bluetooth®

USB and Serial
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Table 8. General Receiver Specifications

Output

Communication Ports

High-speed RS232 serial port (rimmed in black)
USB port up to 12 Mbps (rimmed in yellow)
Internal Bluetooth (port D)

Serial Port Specifications

RS232 Serial Port:

Baud rate: 460800, 230400, 115200 (default), 57600, 38400,
19200, 9600, 4800, 2400, 1200, 600, 300

Flow control: RTS/CTS

Length: 7 or 8 (default)

Stop bit: 1 (default), 2

Parity: None (default), Odd, Even

Connectors

Modem Antenna (BNC or reverse polarity TNC depending on
modem type)

PWR
RS232 Serial
usB

MINTER (LED Display)

6 external LEDs
ON/OFF control input (power button)
Data logging control (FUNCTION button)

General Details

P/N: 7010-1004
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Table 8. General Receiver Specifications

NMEA

NMEA 0183 Output

Ver. 2.1, 2.2, 2.3, 3.0 output

Messages

GGA, GLL, GMP, GNS, GRS, GSA, GST, GSV, HDT, RMS, ROT, VTG, UID,
and ZDA

Output Interval

1Hz standard; 10, 20, 50 Hz optional

DGPS

Correction Format

RTCM SC104 Ver 2.1, 2.2, 2.3,3.0,and 3.1

RTCM Message Type

1, 3,9, 31, 32, 34; user selectable

Process Interval

1Hz standard; 10, 20, 50 Hz optional

Output Interval for RTCM
Correction Data

1Hz standard

Elevation Mask

0 to 90 degrees (independent of data logging)

Real-Time Kinematic Mode

Correction Format®

RTCM SC104 Ver 3.1, 3.0, 2.3, 2.2, or 2.1
CMR/CMR+ (Trimble compatible), TPS proprietary

Supported RTK Network
Solutions

VRS, MAC, FKP

General Details

P/N: 7010-1004
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Table 8. General Receiver Specifications

Ambiguity Initialization

On-The-Fly (OTF): L1, L1/L2

Baseline Length

Up to 50km, depending on atmospheric and multipath conditions

Initialize Time

1 second to 10 min., depending on the baseline length (D) and
multipath conditions

Output Interval for 1Hz standard
CMR/RTCM
Elevation 0 to 90 degrees (independent of data logging)

Solution Mode

Delay (synchronization) mode: 5 to 10 msec
Extrapolation (not synchronized) mode: 10 to 20 msec

Process Interval

1Hz standard; 10, 20, 50 Hz optional

Latency Delay mode: 5 to 10 msec.

Extrapolation mode: 10 to 20 msec.
Status Fix, float, DOP, data link status, modem latency, common satellites
Results RTK coordinates, HRMS, VRMS

General Details

P/N: 7010-1004
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Table 8. General Receiver Specifications

Survey Modes

Base or Rover Autonomous (standalone)

DGPS (w/ user base)

DGPS (w/ SBAS)

Static

Kinematic (continuous, stop and go)
RTK (delay, extrapolation)
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Accuracy (RMS)¢

Static’ H:3.0 mm + 0.1 ppm
V:3.5mm + 0.4 ppm

RTK H: 5 mm + 0.5 ppm
V: 10 mm + 0.8 ppm

DGPS User Base:
H: 0.4m
V:0.6m
SBAS:

H: 1.0m
V:1.5m

Autonomous Accuracy H: 1.5m RMS
V: 2.0m RMS
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Table 8. General Receiver Specifications

a. Patent pending. Multiple patents are associated with Fence Antenna™ technology.

b. A positioning solution for L1C, GPS L5, and Galileo signals will be integrated and made available when
the constellations mature, and are ready for commercial use.

c. A positioning solution with these signals will be integrated and made available when the constellation
matures and is ready for commercial use.

d. CMR/CMR+ is a third-party proprietary format. Use of this format is not recommended and
performance cannot be guaranteed. Use of industry standard RTCM 3.x is always recommended for
optimal performance.

e. Subject to multipath anomalies and atypical satellite geometry. GNSS survey best practices must always
be applied.

f. Under nominal observation conditions and strict processing methods, including use of dual frequency
GPS, precise ephemerides, calm ionospheric conditions, approved antenna calibration, unobstructed
visibility above 10 degrees and an observation duration of at least 3 hours (dependent on baseline
length).

n
O
Cold Start <60 sec. 2
Warm Start <35 sec. =
Hot Start <10 sec. 8
Reacquisition <1 sec. =
o]
=)
n
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DUHF Il Internal Modem Board Details (Optional)

Table 9. DUHF Il Internal Modem Board Specifications

Operating Frequency Range

e 410MHz — 470MHz for Rover
e 420MHz — 470MHz for Base

Channel Spacing

12.5 KHz / 20KHz / 25KHz user-selecable

Signal Modulation

* 4FSK
e GFSK

Communication Mode

Time division duplex

Supported Protocol(s)

Proprietary, PDL, Trimble, Satel

Transmitter Carrier Power

10, 20, 50, 100, 200, 500 and 1000 mW, user selectable

Receiver Sensitivity

GFSK: -119 dBm at 10" BER and 12.5 KHz spacing
4FSK: -114 dBm at 10™ BER and 12.5 KHz spacing

Receiver Dynamic Range

-119 to -1dBm

Serial Data Rate

1200, 2400, 4800, 9600, 14400, 19200, 38400, 57600, 115200 bps,
user selectable

Radio Data Rate

25KHz: 9600 bps for GFSK and 19200 pbs for 4FSK
12.5KHz: 4800 bps for GFSK and 9600 pbs for 4FSK

Antenna Type

Whip antenna

DUHF Il Internal Modem Board Details (Optional) P/N: 7010-1004
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Table 9. DUHF Il Internal Modem Board Specifications

Antenna Connector BNC

Error Correction FEC on/off
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FH915 Internal Modem Board Details

Table 10. FH915 Internal Modem Board Specifications

Frequency Range e 902.2 MHz — 927.8 MHz (128 channels), USA
Country/Region/Purpose e 915.2 MHz — 927.8 MHz (63 channels), AUS
Dependent

¢ 920.8 MHz — 927.8 MHz (36 channels), NZL
Signal Structuring Frequency-hopping spread spectrum
Hopping Pattern 5 per band, user-selectable
Hopping Channels 128 Channels
Occupied Bandwidth + 100KHz
Frequency Modulation FSK, 64 Kbps
Technique
Network Topology Point-to-point, Point-to-multipoint
System Gain 135dB

FH915 Internal Modem Board Details P/N: 7010-1004




Table 10.

FH915 Internal Modem Board Specifications

Operation Mode

Transmitter, receiver, repeater

Protocol

FH915, FH915+

Transmitter Carrier Power

250mW (24 dBm)/1 W (30 dBm), user selectable

Receiver Sensitivity

-105 dBm at 1074 BER

Receiver Dynamic Range

105dB

Serial Interface

RS232

Serial Data Rate

9600, 19200, 38400, 57600 bps, user selectable

Effective Radio Link Rate

9600, 10200, 17000, 51000 bps, user selectable for FH915
3600, 4800, 6600, 19200 for FH915+

Error Correction

FEC (15.7), majority decoding

Antenna Type

1/2 wave articulating whip

Antenna Connector

Reverse polarity TNC

Antenna Gain

2.5 dBi

FH915 Internal Modem Board Details P/N: 7010-1004
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Optional Cell Module Details

Table 11. Cellular Specifications

Quad Band GSM/GPRS/EDGE Module®

Supported Bands

GSM 850/900/1800/1900 MHz

TX Power

850/900 MHz — Class 4 (2 Watt)
1800/1900 MHz — Class 1 (1 Watt)

Data Features

GPRS, Multi-slot Class 10, Max downlink 85.6 kbps, max uplink 42.8
Kbps

EDGE, Multi-slot Class 10, Max BR downlink 236.5 Kbps
CSD, Max BR 14.4 Kbps

AT Command Set

GSM 07.05, 07.07 and 07.10

Regulatory and Approvals

FCC, IC

COFETEL (Mexico)
CMII (China)

PTCRB

R&TTE/CE

GCF

QS9000 manufacturing
RoHS/WEEE/CCC

Optional Cell Module Details

P/N: 7010-1004
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Table 11. Cellular Specifications (Continued)

Dual Band CDMA 1xRTT Module

Supported Bands? CDMA 800/1900 MHz

TX Power 800 MHz — Class 3 (24 dBm)
1900 MHz — Class 2 (24 dBm)
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Data 1x/QNC/HSPD
CSD, Max BR 14.4 Kbps

AT Command Set N/A

Regulatory and Approvals CDG1, CDG2

FCC, IC, CCC

EMC

QS9000 manufacturing
RoHS/WEEE

1Topcon GNSS receivers equipped with integrated C24 wireless modules are authorized to operate in

™

the US only on the Verizon' wireless network.

3.5G Wireless Module (Quad-band GSM and UMTS/HSPA)

Supported Bands GSM 850/900/1800/1900 MHz
UMTS/HSPA 850/1900/2100 MHz

Optional Cell Module Details P/N: 7010-1004 91




Table 11. Cellular Specifications (Continued)

TX Power UMTS/HSPA - Class 3 (0.25 Watt)

GSM 850/900 MHz — Class 4 (2 Watt)

GSM 1800/1900 MHz - Class 1 (1 Watt)
EDGE 850/900 MHz — Class E2 (0.5 Watt)
EDGE 1800/1900 MHz — Class E2 (0.4 Watt)
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Data Features UMTS/HSDPA/HSUPA 3GPP, Release 6

GSM/GPRS 3GPP, Release 9

Max uplink 5.76 Mbps, max downlink 7.2 Mbps

EDGE, Multi-Slot class 12

CSD, Max BR 14.4 Kbps GSM, Max BR 14.4 Kbps UMTS

AT Command Set GSM 07.05, 07.07

Regulatory and Approvals FCC, IC
PTCRB
R&TTE/CE
GCF
RoHS/WEEE
ACMA
BABT

a. The GR-5 receiver, featuring Vanguard technology, supports high speed HSPA cellular modules.

Optional Cell Module Details P/N: 7010-1004 92




Bluetooth Module Details

Table 12. Bluetooth Module Specifications
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Range up to 10 m (indoor); up to 20 m (outdoor)
Type Class 2

Service classes Miscellaneous

Supported profiles LM, L2CAP, SDP, SPP

Frequency Country Code North America and Europe

Connector Specifications

The GR-5 has one antenna connector for radio transmission/reception and three port connectors for power and data
upload/download.
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Radio (Modem) RF Connector

The modem connector (Table 13) is a reverse TNC connector for 915+ radio and a BNC connector for UHF radio.

Table -13. Modem Connector Specifications

Modem Type Signal Type Dir Details

%)
B
o
0
=
0
Q
=,
@)
3
m

915+ Reverse TNC Modem I/O 1/0 RF/GSM output from
modem antenna

DUHFII BNC Modem I/O 1/0 RF/GSM output from
modem antenna

Connector Specifications P/N: 7010-1004




Power Connector

Rimmed in red, the power connector (Figure 28) is a sealed receptacle, 5 pin, ODU part number G80F1C-T05QF00-0000.

%)
B
o
0
=
0
Q
=,
@)
3
m

@ ©

Figure 28. Power Connector

Table 14 describes power connector specifications.

Table 14. Power Connector Specifications

Number Signal Name Dir Details
1 Power_INP P 9 to 21 volts DC input
2 Power_INP P 9 to 21 volts DC input
3 Power_GND P Ground, power return

Connector Specifications P/N: 7010-1004 95




Table 14. Power Connector Specifications (Continued)

2

O

Number Signal Name Dir Details g
=

4 Power_GND P Ground, power return o)
Q
5 Aux_Power P 9 to 21 volts DC input g
-]

V)]

Serial C-RS232 Connector

Rimmed in black, the serial RS232 connector (Figure 29) is a sealed receptacle, 7 pin, ODU part number G80F1C-T07QC00-0000.

®®
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Figure 29. Serial RS232 Connector

Connector Specifications P/N: 7010-1004 926




Table 15 gives the RS232 cable connector specifications.

Table 15. RS232 Connector Specifications
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Number Signal Name Dir Details
1 Not used
2 GND - Signal ground
3 CTS | Clear to send
4 RTS (0] Request to send
5 RXD | Receive data
6 TXD (0] Transmit data
7 Not used
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USB Connector

Rimmed in yellow, the USB connector is a sealed receptacle, 4 pin TPS cable connector (Figure 30).
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Figure 30. USB Connector for GGD Options
Table 16 gives the USB connector specifications.

Table 16. USB Specifications

Number Signal Name Dir Details
1 USB_PWR P Bus power input
2 USB D- 1/0 Data minus
3 USB D+ 1/0 Data plus
4 GND P Ground

Connector Specifications P/N: 7010-1004




Brazil-Only Radio Specifications

The equipment will be commercialized in Brazil only with the following technologies (O equipamento sera comercializado no
Brasil apenas com as seguintes tecnologias):

® Bluetooth V. 2.1 EDR
* Digital UHF Il (459-460 MHz e 469-470 MHz) — Modulagdes GMSK e 4-Level FSK (4LFSK)
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Table 17. Brazil-Only General Information

Parameter Specification
Model (Modelo) GR-5
Description (descri¢do) GR-5 with DUHF (459-460, 469-470 MHz x12.5 KHz spacing) + BlueTooth
Type (Tipo) Transmissor Digital - Categoria Il
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Table 18. Especificages Modem UHF Digital Il para o Brasil

Parameter Specification
Operating Frequency Range UHF 459-460, 469-470 MHz
(Faixa de freqiiéncia de operagao)
Modulation Techniques GMSK and 4-Level FSK (4LFSK)
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(técnicas de modulagao)

Maximum Transmit Power 1 Watt
(Maxima de Transmissdo de Energia)

Protocols Satel 4LFSK
(Protocolos) PDL GMSK
PDL 4LFSK

TrimTalk GMSK

Occupied Bandwidth (channel spacing) |12.5 KHz

Data Transmission Rate at 12.5 kHz 4800, 9600 bps
Channel Spacing

(Taxa de transmissdo de dados de 12.5
KHz canal espagamento)

Data Speed of Serial Interface Max 115200 bps
(A velocidade de dados de interface

serial)

Forward Error Correction Yes (Sim)
Scrambling Yes (Sim)
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Table 18. EspecificagGes Modem UHF Digital Il para o Brasil (Continued)

Parameter

Specification

Communication Mode
(modo de comunicagédo)

Half-Duplex (Meio Duplex)

Oeration Modes:
(modos de operagdo)

Transmitter (Transmissor)
Receiver (Recebedor)
Repeater (Repetidor)

Table 19. Médulo Bluetooth Especificages

Parameter

Specification

Range (Alcance)

Up to 10 m (indoor), up to 20 m (outdoor)
[Até 10 m (interior), até 20 m (ao ar livre)]

Type (Atragdo)

Class 2

Service Class (Classe de Servigo)

Miscellaneous (variado)

Support Profiles (Perfis de apoio)

LM, L2CAP, SDP, SPP

Frequency Country Code
(Frequiéncia Cédigo do pais)

North America and Europe (América do Norte e Europa)

Brazil-Only Radio Specifications

P/N: 7010-1004
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Product Identification

Earlier versions of the GR-5 receiver supported 216 Universal Tracking channels. The new GR-5 receiver, featuring
Vanguard™ Technology, supports 226 channels, which are listed in Table 20 by serial number range.

Table 20. Product Serial Numbers

Cellular Modem Serial Number

GR-5 (With Digital UHF I1)

No cellular modem 1117-2xxxx
HSPA modem 1118-2xxxx
CDMA modem 851-2XXXX

GR-5 (With FH915+)

No cellular modem 800-2xxxX

HSPA modem 1203-2xxxx

You can also identify the new GR-5 receiver, featuring Vanguard Technology, by the serial number label on the
receiver, which contains the Topcon Vanguard Technology logo.
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SD/SDHC Card Recommendations

This section provides a recommended list of SD/SDHC cards that were tested with the receiver. This list of recommendations is
based on testing results available to date and should not be considered a comprehensive list. The receiver is capable of working
with SD/SDHC cards with a storage capacity of up to 32GB.

/QS For optimal and consistent performance, Topcon recommends using the SD/SDHC cards listed in this section.

N

Topcon recommends using the following list of SD/SDHC cards with your receiver:
® Swissbit® Industrial 2GB
® SanDisk® Ultra Il
® Transcends® Ultra Industrial 2 GB
®* APRO® Industrial 4 GB
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Safety Warnings

General Warnings

Topcon receivers are designed for survey/construction and related uses (that is, surveying coordinates, distances,
angles and depths, and recording such measurements). This product should never be used:
® Without the user thoroughly understanding this manual.

* After disabling safety systems or altering the product.
® With unauthorized accessories.

* Without proper safeguards at the job site.

® Contrary to applicable laws, rules, and regulations.
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Battery Warnings

Battery Warnings

M Alojes

Never attempt to open the casing of the detachable batteries! Lithium-lon batteries can be dangerous if
mishandled!
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Do not incinerate or heat the battery above 212 degrees fahrenheit (100 degrees celsius). Excessive heat can
cause serious damage and possible explosion.

Tampering with the batteries by end users or non-factory authorized technicians will void the battery’s
warranty.

¢ Do not disassemble the batteries.

¢ Do not charge in conditions different than specified.

¢ Do not use other than the specified battery charger.

¢ Do not short circuit.

¢ Do not crush or modify.
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Receiver Warnings

Tampering with the receiver by the end users or non-factory authorized technicians will void the receiver’s

warranty:
® Do not attempt to open the receiver and modify any of its internal components.

® Do not charge in conditions different than specified.
® Do not short circuit.

Usage Warnings

If this product has been dropped, altered, transported or shipped without proper packaging, or otherwise
treated without care, erroneous measurements may occur.
The owner should periodically test this product to ensure it provides accurate measurements.

Inform TPS immediately if this product does not function properly.

Only allow authorized Topcon warranty service centers to service or repair this product.

Receiver Warnings P/N: 7010-1004
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Regulatory

The following sections provide information on this product’s compliance with government regulations for use.
FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the FCC radio
frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of RF energy that it deemed to
comply without maximum permissive exposure evaluation (MPE). But it is desirable that it should be installed and operated with
at least 30cm and more between the radiator and person’s body (excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part 15 of the FCC rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his
own expense.
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If this equipment does cause interference to radio or television equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

® Reorient or relocate the receiving antenna.
* Move the equipment away from the receiver.
® Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.

Aioje|n3ay

® Consult the dealer or an experienced radio/television technician for additional suggestions.

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.

Industry Canada Compliance

This equipment complies with IC radiation exposure limits set forth for uncontrolled equipment and meets RSS-102 of
the IC radio frequency (RF) exposure rules. This equipment has very low levels of RF energy that it deemed to comply

without maximum permissive exposure elevation (MPE). Bit it is desirable that it should be installed and operated with
at least 30 cm or more between the radiator and person’s body (excluding extremities: hands, wrists, feet, and ankles).

This class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the following two
conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.
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Le présent appareil est conforme aux CNR d' Industrie Canada applicables aux appareils radio exempts de
licence. L' exploitation est autorisée aux deux conditions suivantes : (1) I’ appareil ne doit pas produire de
brouillage, et (2) I" utilisateur de |’ appareil doit accepter tout brouilage radioélectrique subi, méme si le
brouillage est susceptible d’ en compromettre le fonctionnement.

Aioje|n3ay

IC RF Radiation Exposure Statement

When installing, locate or point this device away from the installer, so it does not emit RF field in excess of Health Canada’s limits
for the general population. Consult Safety Code 6 from Health Canada’s website at www.hc-sc.gc.ca/rpb.

IC Additional Statement with Detachable Antennas

This device 9with UHF Il modem) has been designated to operate with the antennas listed below and have a maximum gain of
2.4dBi. Antennas not included in this or having a gain greater than 2.4dBi are strictly prohibited for use with this device. The
required antenna impedance is 50 ohms.

GR-5 UHF Il 2.4dBi whip antenna
Manufacture/Type

420-450 MHz LAIRD or ANTENEX/G420BN
450-470 MHz LAIRD or ANTENEX/G450BN
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The device (with FH915 modem) has been designated to operate with the antennas listed below and have a maximum gain of
2.1dBi. Antennas not included in this or having a gain greater than 2.1dBi are strictly prohibited for use with this device. The
required antenna impedance is 50 ohms.

GR-5 FH915 2.5dBi Sleeve Dipole Antenna

Aioje|n3ay

Manufacture/Type

890-960 MHz LARSEN SPDA17RP918
Connect Type: TNC male reverse polarity
902-928 MHz

NEARSON S467xx-915S

Connector Type: TNC male reverse polarity
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Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European Community.

Aioje|n3ay

European Community Declaration of Conformity with R&TTE Directive
1999/5/EC

The following standards were applied: (R&TTE Directive 1999/5/EEC)

e ETSIEN 300 113-2v1.5.1(2011-11)

ETSI EN 301 489-5 v1.4.1(2002-08)

o ETSIEN 301 489-1 v1.9.2(2011-09) o ETSI EN 301 489-17 v1.5.1(2010-10)

o ETSIEN 301 489-7 v1.3.1(2005-11) o ETSI EN 301 511 v9.0.2(2003-03)

e ETSI EN 300 440-2 v1.4.1(2010-08) * EN 60950-1:2006:+A11:2009 & A1:2010
e ETSI EN 300 328 v1.7.1(2006-10) e EN 55022:2010

e ETSI EN 301 489-3 v1.4.1(2002-08) e ETSI EN 301 489-24 v1.5.1(2010-10)

e ETSIEN 301 908-1 v5.2.1(2011-05) e ETSIEN 301 908-2 v5.2.1(2011-07)
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This equipment is intended to be marketed in the following countries:
List of National Codes:

* ATDEMTGB
® BEGRNLIS
e CYHUPLL

* CZIEPTNO
®* DKITSKCH
* EELVSIBG
* FILTESRO

® FRLUSETR

Aioje|n3ay

The equipment is labeled with a CE! mark that informs users the DIG UHFII frequency range 410-470 MHz is not harmonized
throughout Europe and the specific country spectrum authority should be notified before a radio modem is used.

@ Use of this equipment requires a license.
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Limpiego di questo impianto necessita una concessione.
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Das Betreiben dieser Anlage unterliegt der Konzessionspflicht.

L'utilisation de cette installation nécessite une concession.
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Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky
[Czech]

Dansk
[Danish]

Deutsch
[German]

Eesti
[Estonian]

English

Espafiol
[Spanish]

(Topcon) timto prohlasSuje, Zze tento (GR-5) je ve shod se
zakladnimi pozadavky a dalSimi pislusnymi ustanovenimi smrnice
1999/5/ES.

Undertegnede (Topcon) erkleerer herved, at fglgende udstyr
(GR-5) overholder de veesentlige krav og gvrige relevante krav i
direktiv 1999/5/EF.

Hiermit erklart (Topcon) dass sich das Gerat (GR-5) in
Ubereinstimmung mit den grundlegenden Anforderungen und den
Ubrigen einschlagigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Kaesolevaga kinnitab (Topcon) seadme (GR-5) vastavust direktiivi
1999/5/EU péhinduetele ja nimetatud direktiivist tulenevatele
teistele asjakohastele satetele.

Hereby, (Topcon) declares that this (GR-5) is in compliance with
the essential requirements and other relevant provisions of
Directive 1999/5/EC.

Por medio de la presente (Topcon) declara que el (GR-5) cumple
con los requisitos esenciales y cualesquiera otras disposiciones
aplicables o exigibles de la Directiva 1999/5/CE.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 7010-1004
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[Greek] ME THN MAPQYZA (Topcon Positioning Systems,
Inc.) AHAQNEIOTI ( GR-5 ) ZYMMOPOQNETAI
MPOZ TIZ OYZIQAEIZ AMAITHZEIZ KAI TIZ ACIMNEZ
ZXETIKEZ AIATAZEIZ THZ OAHIAZ 1599/5/EK.
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Francais Par la présente (Topcon) déclare que I'appareil (GR-5) est

[French] conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE.

Italiano Con la presente (Topcon) dichiara che questo (GR-5) € conforme ai

[ltalian] requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla
direttiva 1999/5/CE.

Latviski Ar S0 (Topcon) deklar, ka (GR-5) atbilst Direktvas 1999/5/EK

[Latvian] btiskajm prasbm un citiem ar to saisttajiem noteikumiem.

Lietuvi Siuo (Topcon) deklaruoja, kad 3is (GR-5) atitinka esminius

[Lithuanian] || reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Nederlands Hierbij verklaart (Topcon) dat het toestel (GR-5) in
[Dutch] overeenstemming is met de essentiéle eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG.

Malti Hawnhekk, (Topcon), jiddikjara li dan (GR-5) jikkonforma mal-
[Maltese] tiijiet essenzjali u ma provvedimenti orajn relevanti li hemm fid-
Dirrettiva 1999/5/EC.
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Magyar Alulirott, (Topcon) nyilatkozom, hogy a (GR-5) megfelel a
[Hungarian] | vonatkozo alapvetd kévetelményeknek és az 1999/5/EC iranyelv
egyéb elbirasainak.
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Polski Niniejszym, (Topcon) , deklaruj, e (GR-5) spenia wymagania

[Polish] zasadnicze oraz stosowne postanowienia zawarte Dyrektywie
1999/5/EC.

Portugués (Topcon) declara que este (GR-5) esta conforme com os requisitos

[Portugues] essenciais e outras disposi¢des da Directiva 1999/5/CE.

Slovensko (Topcon) izjavlja, da je ta (GR-5) v skladu z bistvenimi zahtevami

[Slovenian] in ostalimi relevantnimi doloili direktive 1999/5/ES.

Slovensy (Topcon) tymto vyhlasuje, ze (GR-5) spa zakladné poziadavky a

[Slovak] vSetky prislusné ustanovenia Smernice 1999/5/ES.

Suomi (Topcon) vakuuttaa taten ettd (GR-5) tyyppinen laite on direktiivin

[Finnish] 1999/5/EY oleellisten vaatimusten ja sita koskevien direktiivin

muiden ehtojen mukainen.

Svenska Harmed intygar (Topcon) att denna (GR-5) star |
[Swedish] Overensstammelse med de véasentliga egenskapskrav och 6vriga
relevanta bestammelser som framgar av direktiv 1999/5/EG.
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Brazil Anatel Compliance

Este equipamento opera em carater secundario isto e, nao tem direito a protecao contra interferencia prejudicial, mesmo do
estacoes do mesmo tipo, enao pode causar interferencia a sistemas operando em carater primario.

® EAN Code: 0719-16-6473

* Homologation: (01) 0 789894509888
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GR-5 0719-16-6473

Este equipamento opera em carater

secundario isto e, nao tem direito a

@F) o neencs i RN A
mesmo do estacoes do mesmo tipo, e

ANATEL nao pode causar interferencia a sistemas (01) 0 789894509888

operando em carater primario.
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WEEE Directive

The following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring this product is
disposed of correctly, to help prevent potential negative consequences for the environment and human health, which could
otherwise be caused by inappropriate waste handling of this product. For more detailed information about the take-back and
recycling of this product, please contact a supplier where you purchased the product or consult.
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I
Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

® Baseband

* HCI

® Link Manager

® Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid for any antenna
with the same or less gain.
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Warranty

Topcon laser and electronic positioning equipment are guaranteed against defective material and workmanship under normal use
and application consistent with this Manual. The equipment is guaranteed for the period indicated, on the warranty card
accompanying the product, starting from the date that the product is sold to the original purchaser by Topcon’s Authorized
Dealers.!

During the warranty period, Topcon will, at its option, repair or replace this product at no additional charge. Repair parts and
replacement products will be furnished on an exchange basis and will be either reconditioned or new. This limited warranty does
not include service to repair damage to the product resulting from an accident, disaster, misuses, abuse or modification of the
product.

Warranty service may be obtained from an authorized Topcon warranty service dealer. If this product is delivered by mail,
purchaser agrees to insure the product or assume the risk of loss or damage in transit, to prepay shipping charges to the warranty
service location and to use the original shipping container or equivalent. A letter should accompany the package furnishing a
description of the problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above. In no event shall Topcon be liable for any damages or other
claim including any claim for lost profits, lost savings or other incidental or consequential damages arising out of the use of, or
inability to use, the product.

1. The warranty against defects in a Topcon battery, charger, or cableis 90 days.
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Glossary

Glossary

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for nearby Rover (mobile)
GNSS receivers.

BeiDou— BeiDou Navigation Satellite System maintained and operated by China.

Bluetooth® — Often used in place of cables, Bluetooth is open wireless technology for exchanging data over short distances from
fixed and mobile devices.

G

GALILEO — The satellite system currently being maintained and operated by the European Union (EU) and European Space Agency
(ESA).

GGD — GPS + GLONASS Dual Frequency signal tracking.

GLONASS - The Global Navigation Satellite System maintained and operated by the Russian Federation.
GNSS - Global Navigation Satellite Systems, such as GPS and GLONASS.

GPS - The Global Positioning System maintained and operated by the United States Department of Defense.
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L

L1 and L2- For the ranging codes and navigation message to travel from the satellite to the receiver, they must be modulated
onto a carrier frequency. In the case of the GPS design, two frequencies are utilized: one at 1575.42 MHz (10.23 MHz x 154)
called L1 and the other at 1227.60 MHz (10.23 MHz x 120), called L2.

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s components and
control receiver operations.

Aiesso|n

M
MAGNET Field™ — Data controller software that is part of the MAGNET software system.

MAGNET Office™ — Post-processing and CAD solution software for surveying and grade application. It is part of the MAGNET
software system.

MINTER - The receiver’s Minimum INTERface used to display and control data input and output.

N

Network RTK - Collects satellite observations from the reference stations within the network and sends RTK corrections to the
Rover.

(0]

Option Authorization File (OAF) — This enables specific features for scalable performance of Topcon GNSS receivers.
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P

Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward, with the phase of
the signal being equal at any point on the sphere.
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Pocket-3D - Field data collection software by Topcon for construction markets.

R

Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the measurement quality
without having to process the data.

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.

Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems. SBAS transmits differential
corrections and messages for navigation satellites that are within sight of a network or reference stations in a wide area, such
as a continent.

Static Survey — Location determination when the receiver’s antenna is stationary. This method provides the highest accuracy
and requires the longest observation times.

T

Topcon Receiver Utility (TRU) — Receiver configuration software for receivers and peripheral devices. TRU is included on the
GPS+ Software CD that accompanied your receiver.
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U
Universal Serial Bus (USB) — A connection standard used by devices, such as a receiver, controller, computer, etc.
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